The Northern Marianas College

2009 – 2010
Information Technology (IT) Resource Guide

Faculty Edition

By
Information Technology Department
Media Services
Information Services

Created by Bertha Leon Guerrero in Collaboration with IT Department Team
Concurred by Director Adrian Atalig 1/26/2010
Basic PC, MAC & Networking Troubleshooting ............................................ 57
Disk Cleanup & Defragmenting ................................................................. 57
Basic Troubleshooting Tips ................................................................. 58
The Quick Check List ..................................................................... 58
Five steps to fast Mac troubleshooting .................................................. 60
Basic Printer & Copier Troubleshooting .................................................. 61
Troubleshooting Tips 2 ..................................................................... 63

More on Video-Teleconferencing (VTC) ..................................................... 53
Preparing for VTC Teaching Session....................................................... 53
VTC Etiquette Reminders ................................................................ 54
Tips for Maximizing VTC Experience .................................................... 55

More on Silhouette/Flashlight ................................................................. 44
Requesting Membership ................................................................... 44
Logging In ..................................................................................... 44
Updating Your Profile .................................................................... 44
Basic Features ............................................................................. 45
Creating a New Survey .................................................................... 46
Adding Items ............................................................................... 47
Previewing and Selecting Templates .................................................... 48
Editing Surveys ........................................................................... 48
Starting and Stopping Surveys ........................................................... 49
Accessing Analysis of Data ................................................................. 49

More on Elluminate Live ................................................................. 50
Applications ................................................................................. 50
Features ................................................................................... 50
How to Access and Set Up ................................................................. 52
Accessing Free Online Training ........................................................ 52

More on NMC Online (MOODLE) .......................................................... 38
Requesting a Blank Course ................................................................ 38
Logging In ................................................................................... 38
Updating Your Profile .................................................................... 38
MOODLE Quick Guide for Instructors ............................................... 40
Adding Activities ........................................................................ 41
Adding Resources ....................................................................... 42
About Course Administration .......................................................... 42
Enrolling Students ....................................................................... 43

MOODLE (NMC Online – Course Management System) ......................... 36
TracDat ...................................................................................... 37
PowerCampus (FYI only) ................................................................ 37
Docushare (FYI) ........................................................................ 37

SECTION II .................................................................................. 38

SECTION III .................................................................................. 44

SECTION IV .................................................................................. 53
Printer Troubleshooting Basics for MAC Users ................................................................. 64
**Introduction**

This part of the document provides an overview of technology resources available across campus as well as guidelines on how to access them. To assist you with some of your day-to-day activities we also include a network access and email quick start guide.

**SECTION I**

*Network Knowledge*

**Requesting a Network ID**

One of the most important request new faculty should make here at NMC is a request for a Network ID.

Your Network ID provides access to your:
- Work computer (desktop or laptop)
- NMC Email system
- Network (N) drive

If you haven’t done so already, please take time during this session to request for a Network ID from our Human Resource (HR) office. They can be reached at 234-5498 Ext. 1021, 1016, 1017, or 1018.

**About Your Network ID**

Your Network ID will consist of a **User Name and Password**. Your user name will be your first name followed by the first letter of your last name (i.e. Bertha Leon Guerrero = berthal). Your username and password will be in lowercase.

The Help Desk will set up your local profiles and password on your PC/laptop before you log in for the first time.

**About File Storage**

Once logging in to your computer there are different locations to store files. You have access to storage locations on your desktop computer and you have access to either your department folder or the public folder in the “N” drive.

Neither the files stored on your desktop nor files stored on the network can be accessed from off campus. If you need access to your files off-campus please back them up to a removable storage device or email them to your home or CommuniGate email account.
**Desktop Storage**

Items stored on your Desktop refer to data stored strictly on your hard drive. The most common locations on the hard drive for saving files include My Documents and the folders available under My Computer.

Items that are stored on your hard drive are not backed up on the network nor can they be accessed from other computers on campus. If the hard drive crashes, the information stored on the desktop will be lost.

Forms of removable storage such as CD burners and USB drives (e.g. flash drive/pen drive and external hard drives) are used to store and transport files. We strongly recommend that you store all essential files on the “N” drive.

**Network Storage (the “N” drive)**

To save data to your space on “data on nmc1 (N:)”:

1. Select “My Computer” after logging in to any computer on campus.
2. Under “My Computer” select “data on nmc1(N:)”
3. Once in, click on the folder designated for your department use (Make sure you have authorization from your department head to access this folder)
4. Once in your department space (folder) you can save files and create folders.
5. All files stored on the “N” drive can be accessed from any computer on campus.
Logging On to the Network

To log on to the Network
1. To open the “Log On to Windows” screen, press the [Ctrl+Alt+Delete] keys at the same time. The “Log On to Windows” screen will be presented.
2. Type in your User Name (lastname+firstinitial in the User name field).
3. Next, type in your Password into the Password field.
4. Make sure the Log on to field reads NMC. If another entry is in the field click on the dropdown arrow at the end of the field, then select the correct domain.
5. Click OK or press Enter.

About Passwords

Frequent password changes provide the basis for good information security practice and are essential to safeguarding the College’s network and data. IT recommends that faculty change their College network passwords every 90 days.

Good passwords should be at least 6 characters and consist of both lower and upper case letters, numbers, and symbols. A good way to select a password is to choose a line or two from a song or poem, and use the first letter of each word.
Changing Your Password________________________________________

1. Logon to the desktop then press [Ctrl + Alt + Delete].
   The Windows Security Screen will be presented.
2. Click the [Change Password…] button. The Change Password Screen will be presented.
3. Enter:
   - Your old password in the Old Password field
   - Your new password in the New Password field
   - Re-type your new password in the Confirm New Password field.
4. Click the [OK] button. A Confirmation Message Screen will be presented.
5. Click the [OK] button on the Confirmation Message Screen.
6. Click the [Cancel] button on the Windows Security Screen.

Logging Off vs. Shutting Down_______________________________

When you leave for the day or the weekend you should either log off the network or shut down your computer. To conserve energy it is best to shut down your computer.

If you will be away for an extended period of time such as vacation time or conferences, it is recommended that you shut down your computer.

To log off or shut down the computer:
1. Click the [Start] button.
2. Then click either the [Log Off] or [Shut Down] button.
3. Follow the directions as prompted.

Good Netizenship at NMC______________________________________

- Good fences make for Good Neighbors (virus updates)
- Always use professional, collegial and appropriate language in email
- Be mindful of file size, especially when sending photos
- Use Group addresses purposefully
- Use the NMC discussion groups for non-work related emails such as sales notices and other announcements of a general community nature
- Send your message to the smallest group of readers that you can
CommuniGate Pronto

Email, if not managed and organized in some way, can become overwhelming especially if you are attempting to manage messages from students in different courses, campus mail, special topic related emails, and messages related to appointments, projects, etc. One of the best ways to manage emails is to create personal folders. These folders allow you to sort or file your emails into personal folders.

First Look

- Type the Internet address http://mail.nmcnet.edu into your browser.
- Save address onto your browser by dragging the address onto “browser toolbar”.
- You already know your Username and Password, enter them.
- The skin looks like…

Using CommuniGate Pronto

As a faculty member you will be using CommuniGate Pro (NMC campus mail system) on a daily basis for communications such as email, calendar management, and task management.

To access your personal CommuniGate Pro (NMC Mail) account click on the saved Internet address on your “browser toolbar”.

There are many tools within CommuniGate Pro that you may find extremely useful.

Clicking on the mark will give you access to a quick guide to using each tool. The following are addressed in this section.

1. WebUser Interface Login
2. Mailbox, Mailbox Page List, Message Page
3. Settings Page (Compose, Contacts, Address Book, Calendar and Tasks, Password)
4. Creating Rules to Organize Email
WebUser Interface Login

This Login page allows you to log into the WebUser Interface by presenting your user name and password.

Mailbox, Mailbox Page List, Message Page, and Folders

The Mailbox
This page lists all mailboxes in your account and allows you to create, rename, and remove mailboxes, and to open mailboxes so you can browse the messages stored in your mailboxes.

- 6 Default boxes
- Plus yours!
- Note the features below the line

The Mailbox Page List
This page lists all messages stored in the selected mailbox. You can copy, move, redirect, forward and delete listed messages. You can open and read messages listed on the Mailbox page.

The Message Page
This page presents the content of the selected message. You can read the message, copy, move, delete, redirect, and forward the open message, and you can reply to it.

Folders

Folders Page
This page allows you to manage your email. The following topics are covered:

- Access to Mailboxes
- Mailbox Browsing
- Mailbox Management
- Mailbox Subscription Management
- Mailbox Alias Management
- Access to Mailbox by name

Note: For details, click on the ? marks found on the page.
Settings Page

These pages allow you to customize your WebUser Interface. Items in these pages include:

**Compose Page**
This page allows you to compose a new message, and send it. It can also be used to create and modify Notes, and calendaring (Event and ToDo) items.

**Contacts Pages**
These pages allow you to browse your Contact-type (AddressBook-type) mailboxes (“folders”), and to edit your Contact and Contact Group items.

See Attachment A – “WebMail: Contacts” of this Resource Guide. You may also find these pages by clicking on ? for detailed instructions.

**Address Book**
CommuniGate Pro includes a Global Address Book and a Contacts directory that store email contact information, which are created and maintained by IT (Information Technology) department.

Address Book functionality can be used to select E-mail addresses when you compose messages and meeting requests, and when you compose Contact Groups. Just click on the cup icon to access the directory.

There are several sources for E-mail information that can be used as Address Books:
- all Contacts-type mailboxes
- Directory subtrees you have selected
- Account DataSets

Created by Bertha Leon Guerrero in Collaboration with IT Department Team
Concurred by Director Adrian Atalig 1/26/2010
Calendar and Tasks Pages

These pages allow you to browse your Calendar-type and ToDo-type mailboxes (“folders”).

Password Page

To update your password, enter your current password, then enter your new password twice, and click the Update or Modify button.

Creating Rules to Organize Email

Use this page for…
- redirecting your mail
- vacation messages
- specify rules

Note: Click on the ? mark for detailed information.

Accessing Rules Page

Rules Page

Concurred by Director Adrian Atalig 1/26/2010
Using Microsoft Outlook

Although, as a member of the NMC family, you use CommuniGate Pronto primarily for email communications, you have the option of using Microsoft Outlook for communications such as calendar management, appointment, and task management.

To access your personal Outlook account, simply click on the Outlook icon located on your desktop.

There are many tools within Outlook that you may find useful. The following tools are addressed in this section:

1. Setting Up Personal Folders
2. Using Folders for Email Management
3. Adding Personal Contacts to the Address Book
4. Creating an Appointment
5. Scheduling a Meeting
6. Out of Office Assistant
7. Using Task Manager

Setting Up Personal Folders

One of the best ways to manage emails is to create personal folders. These folders allow you to sort or file your emails into personal folders.

To create a personal folder within Outlook:

1. Click on File > New > Folder on the Outlook menu. A window title Create New Folder will be presented.
2. Type in the Name of your new folder in the Name field.
3. Select the appropriate Options by clicking on the arrow located at the end of the “Folder contains:” field.
4. Next select where you’d like the new folder to be placed.
5. Click the [OK] button or hit Enter key to add your folder.
6. A prompt will appear asking if you’d like to add a shortcut to the shortcuts panel. Press either Yes or No as you prefer.
7. To see where your new folder has been placed, select View > Folder List from the Outlook menu.
Using Folders for Email Management

Moving an email item into a particular folder can be accomplished in three ways.

How to move messages into folders – the easy way

1. Click and hold down the mouse button on the message you want to move.
2. Drag and drop the message in the desired folder.
3. You can highlight more than one message to move to the same folder by holding down the **CTRL** key as you click on each message.
4. Once they are all highlighted, click on one in the group holding down the mouse button and move them to the desired folder.

A word about folders...

The number in parenthesis after the folder name indicates the number of UNREAD messages in that folder. The number of UNREAD messages after the Inbox folders **DOES** not account for the UNREAD messages in the other folders.

A message is considered UNREAD unless it is opened. Reading the message in the split-screen preview is not considered opened.

From an open message:

1. Select **File > Move to Folder** from the Outlook menu. A screen titled **Move Item** To will be presented.
2. Select the Folder you wish to move the item into.
3. Click the [OK] button. The item will be moved to the selected folder.

From a closed message:

1. **Right click** on the message to be moved.
2. Select **Move to Folder**.
3. Click the [OK] button. The item will be moved to the selected folder.

NOTE:
When you add messages under a folder, the folder exhibits a + sign when closed. Click on the + sign to expand the folder and view the messages.
**Address Books**

The Contacts directory can be personalized to include your personal/professional contacts as well as email distribution lists you create. The directions below will provide information on how to add contacts and create personal distribution lists to your Outlook Address Book.

### Adding Contacts

To add a Contact to your personal contacts:

1. Click the **Contacts icon** located in the Outlook Shortcuts column on the left hand side of the screen.
2. The **Contacts – Microsoft Outlook** screen will be presented.
3. Click on the **New Contact** icon in the top left corner of the window or select **File > New Contact** from the menu bar.
4. The **Untitled Contact** window will be presented.
5. Enter the information for your contact in the appropriate fields. The **General Tab** will always be presented first and allows for the entry of common types of contact data. The **Details Tab** allows for the entry of Department, Office, Profession and personal information such as birth date, nicknames, etc.
6. Next click the **Save and Close** field located below the main menu bar to add the contact to the Contacts folder.

![Untitled Contact Window](image)

### Outlook Calendar

The Outlook Calendar can be used in conjunction with or in place of a date book. Using the Outlook Calendar can help you set up meetings, track appointments, remember
appointments, and even invite all selected members of a meeting to attend. The calendar can be accessed and updated both on and off campus.

In the following section we will explore creating an appointment and scheduling a meeting with the Outlook Calendar.

**Creating an Appointment**

To create an appointment entry in the calendar:

1. Click the **Calendar icon** in the Outlook Shortcuts column.
2. The **Calendar – Microsoft Outlook** screen will be presented.
3. Click the **New Appointment** icon at the top left of the window or select **File > New > Appointment**.
4. Enter your appointment information into the appropriate fields.
5. Use the arrows in **Start Time** and **End Time** to set the date and time of the meeting. If the event will consume the entire day, click in the box next to the **Add day event** heading.
6. If a reminder is desired, check the **Reminder box** and select the reminder time before the meeting.
7. When scheduling an appointment on your Outlook Calendar, it is recommended that you adjust the **Show Time As** field to reflect your status during the appointment time.
8. Click the **[Save and Close]** button to add the appointment to your calendar.
Scheduling a Meeting

This feature makes scheduling a meeting among NMC faculty and staff simple, reducing the time spent attempting to juggle schedules. That is, of course, if everyone is using their Outlook Calendars to enter their appointments.

To schedule a meeting involving other individuals on campus:
1. Select File > New > Appointments from the main menu.
2. The Untitled – Meeting screen will be presented.
3. Click on the Attendee Availability to reveal a daily timeline that is segmented into hours.
4. Click in the next available line under All Attendees to enter the name of an individual you wish to invite to the meeting. Type the attendee names directly into the fields.
5. As you add attendees to the list their schedules will be reflected on the timeline revealing a mutual time when all attendees are likely to be able to meet.

Note:
Only the schedules of those faculty and staff members with Outlook accounts will appear in this region. The schedules of Contacts outside of the College will not register on the timeline.
6. Next, complete the **Meeting Start Time** and **Meeting End Time** fields, which appear at the bottom of the screen.

7. Then click the **Appointment Tab**.

8. Note that the individuals invited on the Scheduling page have been added to the **To** line of this message and that the **Time and Date** selected in the Scheduling page appears within the message as well.

9. Enter the **Subject and Location** requesting a meeting and describing the topic of discussion.

10. Click **Send** to invite individuals to the meeting.

11. The meeting will be added to your calendar and the individuals invited to the meeting will receive a message requesting their participation and response.
Using Task Manager

A task is a personal or work-related errand you want to track through completion. A task can occur once or repeatedly. A recurring task can repeat at regular intervals or repeat based on the date you mark the task complete. To create a task in Outlook:

1. Click on the Task icon in the Outlook Shortcuts column.
2. The Tasks – Microsoft Outlook screen will be presented.
3. Click New at the top left hand side of the screen or select File > New > Task.

4. On the Untitled – Task screen, type the Subject of the task.
5. Use the black arrows next to Due Date and Start Date to choose these items from the calendar.
6. To set up a Reminder for this task, simply check the Reminder box and select the date and time for the reminder.
7. Click Save and Close to enter the task into the Task Manager.

A few other mail tools

How to create a signature:
1. Select Tools, Options from the toolbar.
2. Select Mail Format tab.
3. Click the [New] button.
4. Type in a name for your signature file (you can create more than one, but only one can be designated as the default).
5. Click the [Next] button.
6. Enter the signature text in the Display window (Notice you can attach a vcard (electronic business card) with the signature.)
7. Click the [Finish] button to save your signature file.

**Note:** If you have more than 1 signature, you can attach or change to a different signature by clicking on **Insert, Signature** on the toolbar.

**How to Flag a Message for Follow-up: (received message)**

1. **Right click** on the message you want to **Flag**.
2. Select Flag for **Follow up** from the popup window.
3. Select from **Flag to** pull-down menu
4. Select a **Due date**
5. Click the [OK] button
Remote Email Access

Logging in to CommuniGate Web Access

To access your NMC email externally:
1. Log on to the Internet form any computer using any browser.
2. Type in the URL http://mail.nmcnet.edu
3. In the Log On field, type your NMC network User Name.
4. Type in your password.
5. Click Enter

Technology Resources

Information Technology (IT) Office

Location: NMC Building “V”, 1st floor

The Office of Information Technology consists of: Learning Technology, Media Services, and Information Services. IT is committed to providing students, instructors, and staff with the support, training, and tools necessary for using the latest technologies in support of learning at Northern Marianas College.

General Objectives
1. The Office of Information Technology will provide students with support in the use of information technology to help them achieve their academic, personal and career goals.
2. The Office of Information Technology will provide faculty with information technology assistance and service in support of instruction.
3. The Office of Information Technology will provide staff with information assistance and service in support of their work activities.

Media Service Center (MS)

Location: NMC Building “V”, 1st floor

Media Services provides many types of services to the College community, including
- Video production for classroom instruction,
- Video recording of important events, and oral histories.
- Video production of commercials and other recordings for the public sector, some occasions
- Educational video productions for distance education channel
- Creating images for College publications
- Production work for the public sector upon request
• Support of photography courses offered by the College
• Providing and maintaining of audio-visual equipment for the College’s instructional facilities

Media Services includes a modern, well-equipped photographic darkroom for black and white still photography. Video production is accomplished with the latest digital video equipment and professional level Macintosh hardware and video-editing software.

**Information Service Center (IS)**

**Location: NMC Room N-1**

Information Services serves as the backbone for all technological services at the College. The goal of the Information Services section is to provide the College with reliable computer systems, networking, and Internet services, to enable the campus community to function, and communicate effectively twenty-four hours a day.

This section is responsible for:
• Maintaining the administrative and student networks, the student labs, and all computer-related equipment on each of the three NMC campuses.
• Supporting mission-critical core software such as those used in Admissions and Records, Financial Aid, the Budget Office, the Finance Office, and Human Resources.

**Learning Technology Center (LT)**

**Location: NMC Building “V”, 1st floor**

The Learning Technology section is primarily responsible for:
• Providing instructional technology resources for students and instructors
• Developing programs and services that promote and support technology-enhanced learning,
• Providing educational technology related professional development opportunities and resources.
• Supporting faculty use of educational technology with instructional design assistance, technology training workshops, and multimedia production assistance.
Help Desk

How to Install HelpDesk

Please follow the steps below carefully. They have been extensively tested and you should experience no problems.

Go to Windows Explorer (not Internet Explorer) by
- Start -> Programs -> Windows Explorer
- Find the folder named “Data on NMC3” (If “Data on NMC3” is not on your list, simply map to it)
- Expand it by clicking on the “+” sign
• Next, navigate your way down to “Public” and click on it

• From “Public” click on “NMC Software” and

• Click on “HelpDesk Install Package”, expanding each of the folders as you go. The next panel shows how your screen should look.
- For the next step, you need to double-click on the “Setup.exe” to begin the install process. If “you see only “Setup”, double-click on the one listed as an “Application” here.

- The panels below show how your screens should look.
• Just click “OK” when you get the screen below.

![Helpdesk Setup Setup](image1)

• Now, click on the big button (see picture below).

![Helpdesk Setup Setup](image2)

• Click “Continue”

![Helpdesk Setup Setup](image3)
Click on “OK”

Now you need to go to...
Start -> Settings -> Control Panel
Find and double-click on the icon “ODBC DATA SOURCES”

If SQL Server is already on the list, select it and click “Finish”.
Otherwise, click on “Add” and then Scroll down and select SQL Server and click on it. Then just click “Finish”.

Created by Bertha Leon Guerrero in Collaboration with IT Department Team

Concurred by Director Adrian Atalig 1/26/2010
Fill in the boxes with the information shown below.
- Name: “HelpDesk”
- Description: “HelpDesk Data”
- Server: “admsrv1”

After entering the above, click “Next”.

Again, fill in and select as shown below.
- Select “With SQL Server…”
- Select “Connect to SQL Server…”
- Login ID: “sa”
- Leave Password blank.

Now click on “Client Configuration”
- Select “TCP/IP”
- Computer name: “admsrv1”
- Port number: “1433”
- And click “OK”.

- Scroll and select “HelpDesk”
- And click “Next”.
- Make sure this is selected.
- Click “Finish”

- Click “Test Data Source” (to see if you did everything right)
- You did it! Now click “OK”

- Now, close all of the open windows that were left open.

This completes the installation of HelpDesk
**General Desktop Software**

Lab and faculty desktop/Laptop computers have the following software installed.
- Windows XP Operating System
- McAfee VirusScan
- AVG Software
- MS Office XP (Word, Excel, PowerPoint, Access)
- Web Browsers: Internet Explorer & Mozilla Firefox

**Student Computer Labs**

NMC has three computer labs available for student use during the hours posted for each lab. Information about each computer lab appears below.

<table>
<thead>
<tr>
<th>Lab</th>
<th>Location/Hours</th>
<th>Computers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saipan Campus</td>
<td>Building V – First Floor</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Mondays – Saturdays</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time posted on door</td>
<td></td>
</tr>
<tr>
<td>Rota Campus</td>
<td>NMC Rota Computer Enrichment Center</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>Mondays – Fridays 8:00 a.m. – 5:00 p.m.</td>
<td></td>
</tr>
<tr>
<td>Tinian Campus</td>
<td>NMC Tinian Computer Enrichment Center</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Mondays – Fridays 8:00 a.m. – 5:00 p.m.</td>
<td></td>
</tr>
</tbody>
</table>

**Classroom and Department Computer Labs**

In addition to the Student Computer Labs, there are four computer classrooms located in Building “W” and one in the Language Institute in Building “M”. The lab in the Language Institute is run by the Language and Humanities Department.

Computer classrooms in Building “W” are run by IT. Classrooms in Building “W” are, W1, W2, W3, and W4. These rooms can be reserved for special classroom uses. Requests must be made with Joyce Taro at joycet@nmcnet.edu or Ext. 1006.

**Video-Teleconferencing (VTC) Rooms**

NMC currently has 5 VTC rooms. Three on NMC Saipan (D1, N5, & BOR), one on NMC Rota at the Computer enrichment center, and one on NMC Tinian also at the Computer enrichment center.
All of these rooms, except for the BOR can be reserved for classroom use through Joyce Taro. However, for tech support you must consult with the IT department – Extensions 1831, 1832, or 1833.

**Workshops, Trainings, and Tutorials**

The staff at IT provides the following services that may be of great help to faculty.

- Workshops covering design, development, and implementation of instruction via VTC (video-teleconferencing) and MOODLE (NMC Online).
- Individualized faculty/staff consultation in instructional design, technical issues, and multimedia development.
- Faculty and student MOODLE support.
- Workshops on how to develop, administer, and analyze surveys electronically.
- Other workshops on integrating technology into your classroom, as needed.

A schedule of workshops/trainings will be posted on NMC Online, which can be accessed via NMC Website at [http://courses.nmcnet.edu](http://courses.nmcnet.edu)

**Other Resources**

**Audio-Visual Equipment**

Almost all classrooms are equipped with AV equipment and need not be requested if using the room. Use Help Desk for any needed technical assistance.

**Elluminate Live (Web-conferencing)**

Elluminate Live allows for live, multi-media, many-to many collaboration by providing an interactive learning environment that has as one of its partners the MOODLE platform (NMC Online). NMC license accommodates up to 28 participants (users) at any given time. More on Elluminate Live at [http://www.elluminate.com/sales/datasheets/LiveBrochure.pdf](http://www.elluminate.com/sales/datasheets/LiveBrochure.pdf).

**Atomic Learning (Web-based Software Training)**

Atomic Learning is a web-based software training site NMC faculty and staff can access for a variety of software training online such as: MOODLE, PowerPoint, Excel, and numerous other topics on the many software currently in use. To access this website simply go to [http://movies.atomiclearning.com/k12/home/](http://movies.atomiclearning.com/k12/home/)

![Atomic Learning](image)

- Type in the username: (obtain from IT Director)
- Type in the password: (obtain from IT Director)
- Click “Log In”
Click on “Professional Development Activities”.

Click on “training library”.

Locate and click on any of the many available tutorial series.

* Learn to do a mail merge, create a newsletter, create an effective PowerPoint presentation, and set up custom searches in Google.

**Activity-based projects** called Lesson Accelerators can be used effectively as part of a professional development program. As you complete these projects, you will become more comfortable using them in your classrooms.

The Video Storytelling Guide explains and illustrates the “language” of video. Basic video shots and composition rules are explained through both text and integrated video examples.

**Storyboard Pro** is a free software application designed to help you plan and create video projects. Tutorials will walk you through using this tool.

Take the time to learn a new software application. Select an application from the training library and work through all the tutorials in the series.

Use the self-assessment tool to find out what you know about technology, and what you might need to brush up on.
Silhouette Flashlight (Authoring, Taking, & Analyzing Surveys)

Silhouette Flashlight is an online tool for authoring, taking, and analyzing surveys. This tool is available to NMC faculty and staff. To access this tool, email IT Director Atalig at adriana@nmcnet.edu for an account. Once you receive your login ID and password you can log on at http://ctlsilhouette.ctlt.wsu.edu/ctlsilhouette2_5/.

Next...
Click on Group Name (this is usually the name of your department).

MOODLE (NMC Online – Course Management System)

NMC Online is an e-learning platform that provides online access to course materials and tools for communication, collaboration, assessment, and more. It is powered by MOODLE, an open source course management system (CMS) – designed to help educators “web-enhance” their courses, create quality online courses and allow students access to course material anytime of the day or night, from any computer with Internet access.

Training on how to access and use the MOODLE program is available as per request. Your may contact Bertha Leon Guerrero at Ext. 1832 to request individualized or small group training sessions. Furthermore, a brief overview of this CMS is available under Training Session II of this resource guide.
**TracDat**

TracDat is the leading software for program review. It allows for the uploading of and tracking of evidence that links to program review and planning, and budget. The program accommodates program level review and course level review using the Nichols and Nichols five column model. Reports are generated automatically. For more information and training, call Keane Palacios at the Office of Institute Excellence (OIE), Ext. 1840.

**PowerCampus (FYI only)**

PowerCampus, built on advanced Microsoft technologies, features a database design and rules-based processing system that collects and manages student information. In addition, PowerCampus provides administrators and faculty members with relationship management functionality. Moreover, PowerCampus applications help users achieve measurable performance improvement throughout the institution.

**Docushare (FYI)**

DocuShare, a Xerox program, allows for easy and efficient electronic management of content via use of a web browser. DocuShare allows users to create, organize, and share content; collaborate with other users on projects; search for and retrieve content; and automate work processes.

SECTION II

More on NMC Online (MOODLE)

Requesting a Blank Course

To request a blank course on which to build, contact the Distance Learning Coordinator via Ext. 1831/1832/1833. You may also visit the Learning Technology office in Building “V”, first floor in the Learning Technology room.

If teaching a course you have already put online but wish to use for a different session/semester, all you need to do is update and restore the course. For more details, check out the following link: http://docs.moodle.org/en/Backup_restore

Logging In

To access NMC Online directly, go to http://courses.nmcnet.edu/ then log in.

If you don’t have an account with NMC Online the click on “Create new account” and follow the steps given to create your account.

Updating Your Profile

Once logged in, find your name under course created for you and click on it.
Next click on “Edit profile”

Enter all required fields mark with the asterisk *. You may add a picture or image by using the “Browse” button to upload pictures or images.

Click “Update profile”.
To go back to your course, click on “NMC Home”.

MOODLE Quick Guide for Instructors

From the home page, you can access two important resources, which will prove helpful to you when building your course:

1. Moodle Quick Guide for Instructors, and

A simple click will take you directly to these sites.

Contact the IT Distance Learning Coordinator or IT Director for details on available tutorials on NMC Online.
Details on contents, such as “Editing course section”, “Activity modules”, etc., can be accessed, by clicking on each link. The blended training course will provide you with more hands-on guidance (see contact information above).

Adding Activities

Types of activities you can add to your course are listed in the printed screens to the right of this text box. For details, either enroll in the NMC Training session provided by IT Distance Learning Coordinator, or consult the “Moodle Quick Guide for Instructors”.

Clicking on “Moodle Quick Guide for Instructors” takes you to “Getting started for teachers page link” prompt. Click there for detailed instructions on how to start building your course on Moodle.

After reading the “Getting started…” page. Click on each link under “Contents” to learn about the basic tools for Moodle.
Adding Resources

Resources you can add to your course are listed in the printed screen to the left of this text box.

For examples and step-by-step guidance, consult the “Moodle Quick Guide for Instructors”.

About Course Administration

Course administration block

Most of the links in the administration block are only visible and available to teachers of the course. Students see a course administration block with just two links – Profile and Grades (assuming “show grades” is set to yes in the course settings).

Features in the administration block allow teachers to manage Course settings, student and teacher enrollments and their groups, view the course gradebook, create custom grading scales and access the Teacher forum. The teacher forum is a private forum only available to teachers of that course. It can be used to discuss the course content, the direction the course could take or even to attach files to that can be shared among the course teachers.

There are lots of possible ways to set up a course using blocks, but teachers may be particularly interested in course formats which change how the course is presented to the learner. The weekly format is suitable for courses that have a clear start date and activities are presented in weekly blocks. Topic formatted courses are actually presented in a similar way but with the dates removed so activities can belong to general or specific areas of study. The social format doesn’t use much content at all and is based around just one forum which is displayed on the main course page.

In the course homepage there is a white square icon on the top right of a section which can be used to expand and collapse sections. You can also use the light bulb icon to mark a topic as current.

Another much used feature of the administration block is the Files link. From here you can upload any digital content for inclusion in an activity, resource, course section or for a direct download. These files can be moved, renamed, edited directly on the server if they are HTML or text or deleted. You can also create a directory and display the whole contents of that directory to course students using the add resource drop down in any course section. Of course if your content resides out on the web then you don’t need to upload the files at all – you can link directly to them from inside the course using the link to file or website option.

The link was captured from Moodle site at http://docs.moodle.org/en/Course_administration_block

Created by Bertha Leon Guerrero in Collaboration with IT Department Team
Concurred by Director Adrian Atalig 1/26/2010
Enrolling Students

Students can enroll in your class by…

1. Going to NMC Online at http://nmcnet.mrooms.net/
2. Logging in or creating a new account if new to NMC Online.
3. Clicking on the category where your class is located.
4. Clicking on your course.
5. Type in “Enrollment key” you provide.

Note: You must set an enrollment key under “Course Settings” to prevent anyone from taking your course without your approval.

Note: Starting this Fall, 2009, the site administrator will make any course, without an enrollment key, inaccessible.
SECTION III

More on Silhouette/Flashlight

Requesting Membership

As previously noted in Section I of this guide, Silhouette Flashlight is an online authoring, taking, and analyzing surveys tool that NMC subscribes to. To request membership, you must email IT Director Adrian Atalig at adriana@nmcnet.edu for an account.

Once you receive your login ID and password, you can log in at http://ctlsilhouette.clt.wsu.edu/ctlsilhouette2_5/.

Logging In

Updating Your Profile

Click “Profile”

Edit profile then click “reset”.

This is where you can change your password from.
Basic Features

- **Click to find your group.**
- **Click to select a ready-made survey.**
- **Click when creating a new survey.**
- **This is an evaluation handbook that is useful for learning how to create effective evaluation questions, etc.**
- **Used to analyze surveys that have been administered. You may also analyze surveys currently started, but not completed or stopped.**
- **See previous section**
- **Self-explanatory**
- **Use to move survey questions around (i.e. rearranging of questions).**
- **Use to begin administering a survey.**
- **Use when you want to specify respondents. Not for anonymous respondents.**
- **Use to add items/questions to existing or new survey.**
- **Use to stop a survey.**
- **Includes survey title, who can access survey, validation of respondents (if applicable), date created, and purpose of survey.**
- **Use only for deleting an entire survey. Do not use to delete questions in surveys.**

Created by Bertha Leon Guerrero in Collaboration with IT Department Team

Concurred by Director Adrian Atalig 1/26/2010
Creating a New Survey

After logging in, select Group you are assigned to and click. This should be the name of your department.

Click on “new survey”

Enter descriptive information under each of the five sections that describes the basic property of your survey.

Click “o.k.”

To add items or questions click on the “add items”. See “Adding Items” section below for details on how to add questions/items to survey.

Optional:

Provide instructions to respondents.

Click o.k. to save instructions, if provided.

Created by Bertha Leon Guerrero in Collaboration with IT Department Team

Concurred by Director Adrian Atalig 1/26/2010
Adding Items

After clicking on “add items” you will see the screen shown to the right of this text box, which presents a couple of options for adding items:

1. You can select items from an item bank by clicking on “ItemBank Index”,
2. Customize your questions by clicking on “Custom Questions”, or
3. You can use a combination of Flashlight questions and custom questions.

Selecting Questions/Items from ItemBank

Select question type from index.

Table of Contents - select items by category
ItemBank Index - select items by general topic
Educational Inverse Subtokenizer Index - select by subtokenizer
Search for an item
Flashlight Author Guidelines - selection suggestions
Flashlight Evaluation Handbook, yellow book online

The Flashlight ItemBank and the evaluation handbook document excerpts are copyrighted as follows:

Copyright © 1998 Corporation for Public Broadcasting, all rights reserved.
Licensed and published by the CEE Group, the training arm of the National Association for Higher Learning (NAHL) with the aid of funding from the Annenberg/CPB Project.

The custom question itemBank is
Copyright © 1998 Washington State University Center for Teaching and Learning, all rights reserved.

Check mark boxes for questions you want to include in your survey, then click “submit” button to add items to your survey.

Created by Bertha Leon Guerrero in Collaboration with IT Department Team
Concurred by Director Adrian Atalig 1/26/2010
Previewing and Selecting Templates

Click on “templates”

Follow instructions below when using a template for your survey.

[Select Templates]

If you have just created a new blank survey, you can select a template for that survey now. If you already have questions on your survey, you must first choose “new survey” before selecting a template.

- To preview the template before you select that template, click the "View Template" button.
- To select a template for your new survey, click on the template name in the list below.

<table>
<thead>
<tr>
<th>Name of Template</th>
<th>SS number</th>
<th>View the survey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completely Online Course–Faculty Survey</td>
<td>585141</td>
<td>[view template]</td>
</tr>
<tr>
<td>Customer Survey</td>
<td>761292</td>
<td>[view template]</td>
</tr>
<tr>
<td>Dental Program Feedback</td>
<td>5833767</td>
<td>[view template]</td>
</tr>
<tr>
<td>Effectiveness of Faculty Web Page</td>
<td>5854998</td>
<td>[view template]</td>
</tr>
</tbody>
</table>

Editing Surveys

- Log in
- Select Group Name (e.g. Information Technology)
- Select survey (Note: Only surveys that have yet to be started or stopped can be edited)
- Begin editing survey
  - By adding items
  - By deleting items (To delete items uncheck item you wish to delete then click “ok”)
  - By moving items around (To move an item, click on the up or down arrow key in front of the item you wish to move then click “ok”)

Created by Bertha Leon Guerrero in Collaboration with IT Department Team
Concurred by Director Adrian Atalig 1/26/2010
Starting and Stopping Surveys

**To start a survey:**
- Select survey you wish to start.
- Click “Start Survey” from survey toolbar.
- Click “o.k.”
- Click “Send Survey”
- Email survey URL and instructions to respondents.

**To stop a survey:**
- Select survey you wish to start.
- Click “Start Survey” from survey toolbar.
- Click “o.k.”

Accessing Analysis of Data

Once surveyed are started, they can be analyzed at anytime.

- Log in
- Select Group Name
- Click on **Analyze** from top menu
- Select survey and click on it
More on Elluminate Live

Applications

Applications at a glance

Teaching

- Instructor-led courses
- Student projects, collaboration
- Recorded sessions
- Pre-recorded content
- LMS/CMS integration
- Live demos/labs via webcam
- Remote guest lecturers
- Multiple/multimedia learning activities
- Combined online and onsite students
- Home schooling
- Special education
- Online communities

Tutoring and mentoring

- Virtual office hours
- One-on-one instructor or peer-based tutoring
- Mentoring from peers or professionals

Meetings

- Faculty/staff
- Administration/operations
- Parent/teacher
- Idea sharing/brainstorming
- Course content review/update
- Team/project collaboration

Events

- Web-based or blended onsite/online
- Conferences
- Seminars
- Workshops

Professional development

- Faculty and staff training
- New instruction methodologies, best practices
- New tools and technology updates and training
- Policies, procedures dissemination
- Opportunities for teacher communication, discussion, collaboration

Features

Participants Window
- Raise/Lower Hand
- Emoticons
- Step Away

Chat Window
- Permission for using Chat
- Send a Text Message
  - Public
  - Private

Audio
- Permission for Using Microphone
- Audio Set Up Utility
  - Tools > Audio > Audio Setup Wizard
- Optimal Microphone Setting

Whiteboard Tools
- Permission for using Whiteboard
- Tools
  - Selection
  - Eraser
  - Highlighter
  - Text
  - Text Editor
  - Ellipse
  - Filled Ellipse
  - Rectangle
  - Filled Rectangle
  - Line
  - Laser Pointer
  - Import an Image
  - Screen Capture

Polling
- Types
  - Yes/No
  - Multiple Choice
  - Slowdown/Speed up Class Pace
- Responses will appear in the Participants window if the moderator has selected to show them

Resource Materials
- Visit http://www.elluminate.com/training for:
  - User Guides
  - Quick Reference Guides
  - Recorded Training Sessions
  - Register for Live Training Sessions
- The Elluminate User Group available from http://www.elluminate.com/community
- Monthly Live Events and Webinars http://www.elluminate.com/site/external/event/live/schedule
- 3 for Free vRoom http://www.elluminate.com/vroom/

Created by Bertha Leon Guerrero in Collaboration with IT Department Team
Concurred by Director Adrian Atalig 1/26/2010
How to Access and Set Up

Call IS at ext. 1575 to set up an account.

Accessing Free Online Training

You can sign up for free online training sessions at http://sas.elluminate.com/site/external/event/schedule?etn=training&eef=1. Online training sessions are in U.S. Eastern Standard Times.
SECTION IV

More on Video-Teleconferencing (VTC)


(Access above link for detailed information on video-teleconferencing)

Preparing for VTC Teaching Session

Securing VTC Room

- Reserve room (N5/D1) with Joyce Taro @ Ext 1006
- Secure VTC with IT – Media Service – James DeLeon Guerrero / “Butch” Wolf @ Ext 1835 or Distance Learning Coordinator, Bertha Leon Guerrero @ Ext 1832

Setting Up & Testing Equipment

Setting Up, Testing Equipment, and Shutting Down
(Do only when no technical support is available)

- Setting Up
  - Using Remote controls
    - Power on
    - Click “Directory”
    - Scroll to remote site
    - Click ”Enter” to dial in
  - Testing Equipment
    - Adjust on-site camera
    - Communicate with remote site(s) to adjust camera as needed
    - Complete sound check with remote site(s)
  - Shutting Down
    - Hang-up (using remote control)
    - Turn Power off to
      - VTC
      - TV

About Room Configurations

(Essential Considerations)

- All sites should be equipped with all necessary video-teleconferencing hardware and software.
- All sites should have necessary supplies to deliver lessons via VTC.
- All or the majority of students should be on camera, able to see the presenting teacher.
- Room arrangement should reflect the lead teacher teaching all students.
- Possible arrangements:
  - Long tables stretching away from the camera
  - Desks/Tables in arc in front of camera
VTC Etiquette Reminders

Instructions for the convener/facilitator/instructor

_The convener/facilitator/instructor should..._

1. Introduce all participants or allow time for participants to introduce themselves.
2. Arrange with tech support if location names need to be displayed on screen.
3. Name plates or room banners are helpful in identifying participants
4. Make proper/appropriate room configuration/set-up (see attached examples)
5. Remember to invite comments from anyone/everyone. Remember to leave gaps long enough to allow participants to un-mute their microphones and ask to speak.
6. Try not to serve/provide food at host site unless you’ve arranged to have some served/provided at remote sites as well.

**Read out loud to all participants...**

1. Keep microphones muted unless you want to speak.
2. If on “voice switched” mode, be wary that any sound (e.g. sneeze, cough, drumming of fingers, etc.) will cause you to unexpectedly appear on the main screen. *(read only if applicable)*
3. Latecomers should await a gap in the proceedings to announce their presence to the Convener and other participants
4. Alert the Convener if you wish to speak by raising your hand (or using any prearranged non-verbal signal.)
5. Always wait to be recognized before speaking.
6. Be mindful of participants at remote sites
7. When moving…
   a. Limit movements (ex: pacing)
   b. Movements should be slower than normal
   c. Avoid fidgeting
8. Be mindful of the following camera etiquette…
   a. Look into the camera (of remote site participants) as well as those at your site.
   b. Acknowledge the remote site(s)
9. Follow these auditory suggestions…
   a. Repeat responses & questions
   b. Enunciate clearly
   c. Avoid dropping voice volume at end of your sentence
   d. Avoid turning your head when you speak
10. Avoid putting your hands or papers in front of the sensor if wearing a microphone with a sensor that allows a camera to follow you when you walk.
11. **To all remote sites.**
   a. Participate actively in the session
   b. Be mindful of other sites (remote or hosting)
   c. Alert the host site if any of the following occurs…
      i. You are experiencing technical difficulties
      ii. You are unable to see speaker(s)
      iii. You wish to speak
      iv. You are unable to see speaker(s)
      v. You are unable to hear speaker(s)
## Tips for Maximizing VTC Experience

| Goals and Objectives | • Articulate and share goals of course and the role of VTC in achieving them.  
• Plan day-to-day activities and lessons that lead to accomplishment of goals |
|----------------------|------------------------------------------------------------------|
| Demonstrations       | • Ensure supplies for presentations are available at all sites  
• Camera should be arranged to clearly show demonstration  
• Practice demonstration before presenting in front of the camera |
| Supplies             | • Have supplies close during presentation  
• Make sure supplies are available at all sites |
| Interactions/Participation | • Plan for student engagement  
• Detail expectations and procedures for student participation  
• Remind students periodically of expectations and procedures  
• Communicate special instructions for participation prior to videoconference or at the start of class |
| Activities           | • Allow for student participation in at least one activity during videoconferencing  
• Engage students’ multiple intelligences |
| Questions            | • Allow all sites to participate in question-and answer sessions and discussions |
| Preparation and Delivery Time | • Allow for more time in preparing and delivering a class via VTC  
• Organize all images and material for easy accessibility during class  
• Have contact information for troubleshooters on hand in case of any hardware or software problems |
| Communication in Class | • Display countdown clock showing the time until class begins  
• Have each site display a unique identifying image at the start of class for purpose of roll call by presenting site  
• Have each site designate a spokesperson for all interactions. Rotate responsibility  
• Plan for alternate ways of communication in case communication via VTC is cut off (i.e. e-mail, chat room, telephone, or fax)  
• Match communication method with activity to maximize effectiveness and |
### Communications Outside of Class

- Provide opportunities for students to communicate with lead teacher outside of class

### Assessment

- Consider a combination of the following means of assessing student work
  - Demonstrations participation
  - Displays of portfolios
  - Essays Projects
  - Journals, Tests (written or oral)
  - Oral presentations

- Make time to evaluate VTC course, procedures, and teacher at mid- and end-of-course
Basic PC, MAC & Networking Troubleshooting

Disk Cleanup & Defragmenting

Periodically (weekly) clean up your computer's disk drive to maximize its performance. For detailed instruction in movie format, check out Atomic Learning at http://www.atomiclearning.com/k12/home?from_legacy=1 under PC Maintenance and Security...

Click on
- Start
- All Programs
- Accessories
- System Tools
- Disk Cleanup

Created by Bertha Leon Guerrero in Collaboration with IT Department Team

Concurred by Director Adrian Atalig 1/26/2010
Basic Troubleshooting Tips

**The Quick Check List**

This is a very basic guide of what to check when your computer is behaving abnormally. By checking a few simple items, and trying a few things you may be able to 'repair' the machine yourself. If a quick solution is not found, this process may help you to describe the problem more effectively to IT Staff.

If your Computer is not functioning properly check the items on this list first:

1. Ensure the PC is plugged in to a power supply and turned on (make sure all components are on: the monitor, the printer)

2. Look for any loose or damaged cables and cords that attach to your computer.

   **Note**. as with all electronic equipment, be wary of the electrical hazards. It is not wise to open up the computer unless you know what you are doing. There is a risk of electrical shock, and a fairly high risk of damaging the electronic components inside the PC.

3. Make sure that all of your floppy drives are empty (normally all floppy drives should be empty when booting the computer, unless you want to boot from a floppy disk)

4. Check with other users of the network in your vicinity to see if their PC's are functioning normally. Often a downed network can cause a variety of errors when running applications. The problem may not be with your machine, but with the network.

5. If all of the above seems to be fine, try turning off the computer completely and restart it (cold booting). Sometimes this is enough to reset the software and network connections and get the machine back to working order.

<table>
<thead>
<tr>
<th>Trouble with…</th>
<th>What you should do…</th>
</tr>
</thead>
</table>
| **No Power**  | - Make sure that the power button on the computer and on the monitor is turned on.  
- Check the cables attached to the back of your computer. Make sure the power cable is securely plugged into the computer. If it is only the monitor that will not power up, make sure that the power cable to the monitor is securely plugged into the back of the monitor.  
- Check the other end of the power cables to make sure that they are plugged securely into a surge protector or battery backup.  
- If using a battery backup, ensure that the power is turned on.  
- If you have checked all of the above, and there is still no power to your computer or your monitor, submit a helpdesk to IS. Explain the steps you have taken to try to eliminate the problem. |
### The Light On The Monitor Comes On, But There Is Nothing Showing On The Screen
- Check the cable that runs from the back of the monitor to the computer. Make sure it is securely connected to the computer, and that the screws are tightened. Then reboot the machine.
- If you have checked this, submit a helpdesk to IS. Explain that you have checked the cable.

### It Takes Longer Then It Used To Load A File Or To Start A Program On The Machine
- The files on your hard drive may have become badly fragmented (i.e. saved in non contiguous pieces all over the hard drive). In cases of a fragmented hard drive a program trying to load will have to look in several different locations for pieces of the file. This can take a long time.
- On a Windows XP machine, choose 'Disk Defragmenter' from the 'System Tools' area under 'Accessories' in the "Programs" area of the "Start Menu". Choose to defragment 'All hard drives'.
- The 'Defrag' program will physically move the files on your hard drive so that all the pieces of the file are stored contiguously. This will make quite an improvement in the speed of the computer when trying to load files. This utility should be run about once a month just to keep your system working at optimum performance.

### Ways to Handle PC Crashes (Using MS Windows)

#### Faults and Hangs
In general, crashes fall into one of two broad categories: faults and hangs. A program hangs when it suddenly stops responding to the system. Often your mouse cursor will either freeze in place or disappear. In any case, clicking your mouse or pressing a key on your keyboard will accomplish nothing, except perhaps for producing an annoying error tone.

When a fault occurs, a message box pops up. If the problem is relatively minor, you will see something like An error has occurred in your application... and you will be given the option to ignore the problem and attempt to save your work or close the program immediately. More severe problems invoke a message similar to This program has performed an illegal operation and will be shut down..., and any unsaved work in that program is lost. The worst cases bring up the infamous "blue screen of death", an informal Windows user name for that blue screen that fills your monitor with a message beginning A fatal exception has occurred..., which usually results in the loss of all unsaved work in all open programs.

#### Recovering from a Hang
- If you encounter a hang, do not get frustrated and immediately turn off your computer. This action will always result in the loss of all unsaved work and could even damage your vital Windows files. Often you can still access the Close Program dialog box, which allows you to shut down the unresponsive program to return control of the computer to Windows and at least save your work in any other open programs and perform a safe, controlled shutdown.
- To access the Close Program dialog box, press the Ctrl key on your keyboard. While holding that key down, press the Alt key. Continue to hold both keys down while you press the Del key.
- If nothing happens, you're out of luck and will most likely be forced to simply turn the computer off. Usually, however, a dialog box will open.
- It will list all of the programs currently running on your computer. The name of the program that hung will often be followed by the words not responding. Select that program by clicking on it once to highlight it (or by selecting it with the arrow buttons on the keyboard) and press the End Task button at the bottom. It usually takes about 15 seconds for the program to be closed, so be patient. This nearly always returns control to the operating system, although you still lose any unsaved work in the hung program.

#### Handling a Fault
- If you encounter a fault, before you do anything, click the Details button on the dialog box that appears and write everything down exactly as you see it. Save this information where you can...
find it. Make sure you write down what type of fault occurred -- there are many different types. Even if this information means nothing to you, it is invaluable to technical support people if they need to be called in. A recurring problem in the same program or device driver will pinpoint the problem to a specific program or piece of hardware.

- If you succeed in closing the unresponsive program, keep bringing up the Close Program dialog and shutting down programs (even though they might not be listed as not responding) until you can get a clean shutdown. When closing programs always remember to keep the application named Explorer for last. Explorer is the application that runs the Windows User and you cannot run Windows without this interface, so Windows will immediately load a new copy.

- If shutdown hangs at the Please wait while your computer shuts down screen, give it a minute. If nothing happens turn the computer off and back on. You shouldn't encounter major problems if you make it to this point of the shutdown procedure, and there really is nothing else you can do to get past this.

- Important: Any time that you are successful in restoring control to the operating system after a hang or a fault, save all you work in the remaining open programs, close them, and reboot the computer. Although everything may now seem fine, these problems often cause a lingering instability in Windows and could lead to more problems and often more serious ones. Rebooting will restore all resources to the system.

### When to Call in a Computer Technician

- Almost all PC’s will have an occasional problem. The occasional fault or hang, if recovered from with no further problem, is not a concern. It is when the problem occurs fairly often that repairs may need to be done.

- Reoccuring problems should be attended to by IS. When a problem reoccurs, note what you were doing when things went awry: what application you were using and what you were working on. It is often the case that a problem resides with a specific application or file and this information may help IS repair the problem. Also, note any changes made to the computer system shortly before or at the time the problems began to occur. At times, installing a new application, adding a new peripheral, or otherwise altering the configuration of the computer can cause problems in seemingly unrelated areas.

### Five steps to fast Mac troubleshooting

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Restart</strong>&lt;br&gt; If your Mac’s performance has slowed to a crawl, or if your applications are freezing, restarting is often all you need to do to get back on track.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Log In with Startup Items Disabled</strong>&lt;br&gt; Log out of your account and log back in— but hold down the shift key when clicking on the Log In button. Continue to hold it until the desktop background appears. You’ve now disabled your Startup Items, the applications that load automatically when you log in. If one of these items was causing a conflict with the software you were trying to use, you should now be good to go.&lt;br&gt; <strong>A clean break:</strong> If restarting your Mac doesn’t help, try logging into a “clean” account—but first turn on Fast User Switching.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Switch to a Clean Account</strong>&lt;br&gt; Log in to a separate account, ideally a test account set up in advance for just such occasions. To make this go as quickly as possible, use Fast User Switching (enabled from the Accounts preference pane). If the problem does not occur in the test account, it’s likely due to a file that affects only your Home account. You can diagnose that later. If...</td>
</tr>
</tbody>
</table>
you’ll need access to a specific document (such as a Keynote file) while in the test account, copy the file to your Public folder before switching accounts.

### 4 Do Disk Repairs via Single-User Mode
To fix a corrupt directory, the common recommendation is to use Disk Utility’s Repair Disk option. The only problem is that you can’t repair the current startup volume with Disk Utility. Instead, you need to start up from a Mac OS X Install CD and run Disk Utility from there.

But what if you don’t have an Install CD handy, or what if you don’t have time to use one? The quicker alternative is to boot up in single-user mode by holding down Command-S at startup. When the text prompt appears:

- `type fsck -fy` *(This is almost identical to using Disk Utility. When you’re finished, type)*
- `reboot` to restart the Mac.

### 5 Repair Disk Permissions
If you’re seeing error messages that say you don’t have permission to do whatever you’re attempting, select Repair Disk Permissions from Disk Utility. You can (and, in fact, should) do this when you boot from the startup volume that is giving you trouble.

---

## Basic Printer & Copier Troubleshooting

<table>
<thead>
<tr>
<th><strong>Problem</strong></th>
<th><strong>What you should do…</strong></th>
</tr>
</thead>
</table>
| *When you are having problems printing, it is important to determine if everyone is having a problem printing to this printer or if you're the only one having a problem.* | **1.** If everyone is having a problem, it is likely there is either something wrong with the printer or there is a network problem.  
**2.** If only you are having a problem, it is likely a problem with your PC, your connection to the network (or printer) or a problem with the application or file you are working with. |
| **Printer Display Errors** | Most networked printers will have a display that will tell you its status. |
| **No Display** | Turn the printer on. |
| **Offline** | *Press the Go or Online button.*  
If this does not change the printer display to Online: Power the printer off for 1 minute and then turn it back on. |
| **Paper Jam** | *Open the doors and remove any paper, being careful not to tear it and lose pieces inside. Paper may also be lodged under the toner cartridge so you may have to pull it out.*  
*If you believe you have removed the paper but the display still says Paper Jam, power the printer off for 1 minute and turn it back on.*  
*If the jam is severe,* an Information Services technician can help remove the jam. |
<table>
<thead>
<tr>
<th><strong>Contact the Help Desk.</strong></th>
</tr>
</thead>
</table>
| **Processing Job** | - If the printer displays Processing Job but nothing is printing the job may just be really large and taking a while to print.  
- If it has not printed after 5 minutes, press the Cancel Job button on the printer.  
- If the job will not cancel, power the printer off for 1 minute and turn it back on. |
| **IO or Other Error** | - Most IO errors will be cleared by powering the printer off for 1 minute and turning it back on.  
- You may also need to check to make sure the network cable on the printer is plugged securely into the printer and into the network jack on the wall. |
| **Tray Empty** | - Add paper to the appropriate tray |
| **Flashing Lights** | - Most personal DeskJet, ink jet and bubble jet printers will have flashing light codes to tell you what is wrong. These differ from manufacturer to manufacturer and also from model to model.  
- Consult your manual or manufacturer's web site. |
| **No Error on the Printer Display** | - If the printer display says Ready or Power Save but you are still unable to print, there are other troubleshooting steps. |
| **Work Offline/Pause Printing** | - Click Start > Settings > Printers.  
- Right-click the printer.  
- Make sure Work Offline or Pause Printing are NOT selected. If either is checked, click it to remove the check.  
- If the print job does not print, reboot your PC  
- When you log back in, you should get a message that there is a job in the queue.  
- You can choose to print it at this point. |
| **Cable Connections** | - Check to make sure all cables are connected securely. This includes the power cable, connections from your PC to the printer (for a local printer) and connections from the printer to the network jack in the wall (network printers.) Sometimes they look like they're plugged in all the way when they're not.  
- To be safe, unplug the cable and plug it back in, especially the network cable. |
| **Printer Drivers** | - In the case of local printers, sometimes a driver can become corrupted.  
- Try downloading the newest driver from your manufacturer's web site and reinstall the printer. |
| **Software vs. Document** | - Sometimes, the problem printing is related to one particular software package or a certain file.  
- Try printing from another application such as Word, WordPerfect, GroupWise, Excel, |
File Problems

- If you can't print from any other applications, reboot your PC and check the printer for any error messages.
- If you can print from another application, it could be a problem with the application itself or there could be something wrong with the file you are working on.
- Try opening a new, blank document, typing in a few words and try to print the new document.
- If it prints, there is something wrong with your file.
- If it doesn't print, reboot your PC and try printing again.
- If it still doesn't print, try reinstalling the application.

Deleting Stuck Print Jobs

- Sometimes print jobs may get stuck in the queue and will need to be deleted before anyone else can print.
- To delete a print job, press the Cancel button on the printer.
- You can also delete your own jobs by clicking Start > Settings > Printers, double-clicking the printer and deleting the job from the list.
- If you are having a problem deleting a print job, please contact the Help Desk. The printer may need to be powered off for 1 minute to clear out its internal memory.

Troubleshooting Tips 2

Here are a few simple techniques that will solve many printer problems:

1. Reboot your computer. This generally solves most printing problems.

2. If it's not printing, or you're getting a message about the Fax printer, change your default printer: Start - Settings - Printers/Faxes. Right-click the printer you want, and then select (left-click) Set as Default.

3. Check and make sure all connections going to and coming from the printer are firmly in place.

4. Check that the printer is on-line:
   - Start - Settings - Printers, right-click the printer.
   - If there isn't a checkmark by "Set as Default", left-click that option to select it.

5. Print a test page. If that prints and the application you are using doesn't, you probably will need to contact the application's vendor for support.

6. Turn off your printer for 10 seconds and turn it back on. Make a note of any error messages or flashing lights when the printer is turned back on.

7. If your printer is connected directly to another computer, try rebooting that computer. If your printer is connected to a JetDirect box, try unplugging the JetDirect box for 10 seconds.

*If none of the troubleshooting tips provided above worked, please submit a Helpdesk request, or email and contact your campus I.S. Department.
## Printer Troubleshooting Basics for MAC Users

<table>
<thead>
<tr>
<th>Check the power</th>
<th>Make sure your printer is turned on and has power.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check the paper</td>
<td>Make sure you have paper in the paper tray. Typically, if there's no paper, you'll see an alert on either your Mac's display or the printer's LCD panel. Check the printer even if no error message pops up on your screen.</td>
</tr>
<tr>
<td>Check the connection</td>
<td>Check that the cable (probably USB) connecting the printer to your Mac or router is plugged into its appropriate port. If necessary, try a different USB port.</td>
</tr>
<tr>
<td>Check what's selected</td>
<td>If you have more than one printer connected to your Mac, make sure that you've selected the one you want, in the Print dialog box's Printer pop-up menu. For example, if you've selected a printer that's currently turned off, nothing will happen. <strong>Tip:</strong> If subsequent visits to the Print dialog box reveal that the Printer pop-up menu has reverted back to the wrong printer, go to the Print &amp; Fax system preference. From the Default Printer pop-up menu, select your desired printer.</td>
</tr>
<tr>
<td>Check for ink issues</td>
<td>If the printer's ink or toner is low, replace it. Low ink or toner is much more often a problem with inkjet printers than with laser printers. Making matters worse, many inkjet printers are notorious for not printing at all when even one of their multiple ink cartridges is empty. In other words, if your printer is out of yellow ink, you may not be able to print a black-and-white text-only document. When your printer's ink needs to be replaced, you should get an alert message on both your Mac and the printer's display. If you don't see a warning but suspect a problem, select your printer in the Print &amp; Fax system preference, click on Options &amp; Supplies, and then click on the Supply Levels tab for information. You might see only an &quot;Information Not Available&quot; message. In that case, use Spotlight (command-spacebar) to see whether your printer came with its own utility. (For example, I searched for Canon on my Mac and found the Canon IJ Printer Utility located in my /Library/Printers/Canon/BJPrinter/Utilities folder.) Try launching the utility directly. Note that printer utilities typically don't work if a printer is connected to a Mac over a network—for example, through an AirPort Base Station. To work around this, temporarily connect...</td>
</tr>
</tbody>
</table>
your printer directly to one of your Mac's USB ports.

**Tip:** A message that says you're low on ink may be incorrect. Especially if you haven't used the printer for a while, the problem may be that the print head's nozzles are clogged. To check for this, and hopefully fix the problem, clean the nozzles with the appropriate feature in the printer's utility. (The manual that came with your printer should provide details.)

*If none of the troubleshooting tips provided above worked, please submit a Helpdesk request, or email and contact your campus I.S. Department.*

*If none of the troubleshooting tips provided above worked, please submit a Helpdesk request, or email and contact your campus I.S. Department.*
Acknowledgement

This guide was created by Bertha Leon Guerrero, (Distance Learning Coordinator), under the directive of Adrian Atalig (Director) and in collaboration with the following IT team members:

Eric Abangan – Administrative Manager
Jovian Aramada – Network Specialist
Juan L. Babauta – ANA Project Director
Daisie Camacho – Program Manager
James De Leon Guerrero – Program Coordinator Media Services
Dwayne Maratita – Distance Learning Facilitator (Rota)
Sue Palacios – Distance Learning Facilitator (Tinian)
John Quitugua – Computer Lab Assistant
James Revilla – Database Administrator
James Santos – Network Specialist
“Butch” Wolf – Media Specialist